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Welcome to a new world of adventure. Your new 
StarShoot Deep Space Color Imaging Camera (SSDSI) 
is capable of capturing detailed, full-color images of 
astronomical objects. Galaxies, star clusters, and nebu-
lae, as well as the planets, Moon, and Sun (with optional 
solar filter) can all be imaged to create spectacular views 
on your computer (laptop recommended, see “System 
Requirements”) which can be saved for emailing or printing 
later. You’ll find that this relatively inexpensive, yet power-
ful, camera will enhance your astronomical journeys with 
your telescope. 
Please read this instruction manual before attempting to use the camera or 
install the needed software. For the most detailed information on specific 
camera and software functions, consult the Maxim DL Essentials Help menu; 
the tutorials found there are especially useful for familiarizing yourself with how 
the software and camera are typically used.

Parts List
• StarShoot Deep Space Color Imaging Camera

• IR filter

• USB cable

• 12V DC power cable (for TEC power)

• Parfocal ring

• CD-ROM

System Requirements (refer to Figure 1)

Telescope
The SSDSI can be used with virtually any telescope that is compatible with 
1.25" format eyepieces. The camera simply is inserted into a focuser in the 
same way as a standard eyepiece (Figure 2). 

Important Note: Be sure to always firmly tighten the thumbscrew(s) that 
secures the SSDSI in the telescope focuser, or it could fall out and onto the 
ground!

Figure 1: To use the SSDSI, a telescope, mount, computer, and 12VDC power 
source (for TEC usage only) are required.

Figure 2: The SSDSI fits into 1.25" focuser, just like a standard 1.25" eyepiece. 
Firmly tighten the thumbscrew that secures the SSDSI in the focuser.
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In order to reach focus, the telescope must have approximately 0.8" (20mm) 
of inward focus travel relative to where a standard eyepiece focuses. If your 
telescope does not have enough inward focus travel, you will need to use 
and optional 1.25" barlow lens to extend the telescope’s focal plane to the 
camera’s imaging plane.

For most types of astro-imaging with the SSDSI (except planetary imaging), 
using a telescope with a focal length of under 1000mm is recommended. 
Otherwise, the field of view may be too small to capture the entire deep sky 
object. To decrease the effective focal length of your telescope, use a focal 
reducer lens (available from Orion). If you are imaging planets, however, you 
will benefit from using a telescope with a long (over 1000mm) focal length. Or 
you can use a barlow lens to extend the effective focal length of your telescope 
to increase planetary image scale.

Mount
An equatorial mount with right ascension motor drive is required for deep sky 
imaging with the SSDSI. Otherwise, objects will drift in the field of view as the 
image is being captured. It is also very important that the mount tracks very 
accurately with little periodic error. If not, stars will not appear round in the final 
image. Use a sturdy mount that is appropriately sized for the telescope tube 
being used. Accurate polar alignment will also be required.

Computer
A computer is needed. For astro-imaging in the field at night, a laptop com-
puter is highly recommended. Maxim DL Essentials requires Windows 98™, 
Windows ME™, Windows NT™ 4.0, or Windows 2000™ (or higher). 

The following hardware is required:

 • Processor – Pentium™ or equivalent, or higher 

 • Recommended minimum memory size is 64 MB. 

 • Disk Space – 67 MB for program installation, 100 MB swap file recom- 
    mended

 • Video Display – 800 X 600, 16-bit color or higher. 1024x768 or higher is  
    recommended. 

 • Mouse

 • Internet Explorer 4 or higher required to display on-line help

 • USB port (USB 2.0 recommended) 

Note that Maxim DL Essentials benefits greatly from increased memory size. 

12VDC Power source
In order to provide power for the SSDSI’s thermoelectric cooler (TEC), an 
external 12VDC power source is needed. A portable rechargeable battery, like 
the Orion Dynamo, will generally be most convenient to use. The TEC draws 
about 0.5A of current, so make sure your battery has enough amp-hours of 
storage to handle your observing sessions (7amp-hours or more recommend-
ed). When the external 12VDC power supply is connected to the SSDSI (via 
the supplied 12VDC power cable, see Figure 3) the TEC is on. When no power 
supply is connected, the TEC is off.

Keep in mind that the SSDSI camera will run off the power supplied by your 
computer’s USB port, it is only the TEC that needs external power. So if you 
do happen to run out of external 12VDC power in the field, you can still run the 
camera without the TEC. If very cold outside (around or below freezing), it may 
not be necessary to use the TEC. 

Software and Driver Installation
Before the camera can be used, software and camera drivers must be installed 
onto your computer. Turn on your computer and allow the Windows operating 
system to load as normal. Insert the included CD-ROM into your computer’s 
CD-ROM drive, and the Launcher will appear (Figure 4). This allows you to 
install the Maxim DL Essentials software. After the software is installed, the 

Figure 3: Connect the 12VDC power supply to the SSDSI’s TEC with the supplied 
cable.

USB cable

12VDC power 
cable
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drivers will install automatically once the SSDSI is initially connected to the 
computer. Do not connect the camera to your computer before you have 
installed the software.

Software Installation
To install Maxim DL Essentials Edition:

1.  Insert the CD-ROM into the drive. The Launcher will appear.

2.  Click Install.

3.  The InstallShield Wizard will start. Click Next.

4.  Read the Maxim DL License Agreement. If you agree with the terms, then 
select I accept the terms in this license agreement and click Next. 

5.  You are now ready to install. Click Install. The installation will proceed.

6. Microsoft DirectX 9 or higher is required. Click Yes to install the update.

7. The installation is now complete. Click the Finish button.

You can start Maxim DL Essentials Edition using the desktop icon, or using the 
Windows Start menu.

Camera Driver Installation
Now that the software is installed, the camera driver must also be installed. 
The system will automatically guide you through driver installation when the 
SSDSI is initially connected to the computer. You must plug-in the camera 
before starting Maxim DL Essentials Edition, or the software and computer will 
not recognize the camera. 

To install the camera driver:

1. Make sure the CD-ROM is in the drive. 

2. Connect the Orion StarShoot Deep Space Imager to a USB port on the 
computer with the supplied USB cable. Windows will automatically detect 
the camera and start the Found New Hardware Wizard (Figure 5). 

Note: For best results, use a USB 2.0 port. If you only have USB 1.1, the cam-
era will run slower. We highly recommend upgrading to USB 2.0 if you have 
USB 1.1. A USB upgrade card can be found from a computer parts supplier.

Note: You do not need to connect the SSDSI to the external 12VDC battery (via 
the supplied 12VDC cable) at this time. The external power is for the camera’s 
thermoelectric cooler (TEC) only, and normal camera operation does not 
require it to be on (i.e. when the TEC is powered it is on, when it is not powered 
it is off). Use of the TEC is highly recommended for long exposure astro-imag-
ing, however (see “Imaging Deep Sky Objects”).

3. Select Install from a list of specific location (Advanced) and click Next.

4. Select Search removable media (floppy, CD-ROM...). Turn off the other 
options. Click Next.

5. Windows will start looking for the driver files on the CD-ROM. 

6. Windows will note that the driver is not signed. This is normal. Click the 
Continue Anyway button.

7. When the Wizard has completed, click the Finish button. This completes the 
first part of a two-part installation process. (The first step installs the driver for 
the camera’s chipset; the second step installs the camera driver.)

Figure 5: When initially connecting the SSDSI to a computer, 
the Found New Hardware Wizard will appear and guide you 
through driver installation.

Figure 4: The Launcher provides an easy menu for software 
installation.
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8. The Found New Hardware Wizard appears again. Select Install the soft-
ware automatically (Recommended) and click Next.

9. Select the driver with the location c:\windows\inf\dj.inf and click Next. 
Your system should automatically locate the ezusb.sys driver file; if it does 
not, manually select it from its location on the CD-ROM. 

10. Windows will note that the driver is not signed. This is normal. Click the 
Continue Anyway button.

11. When the installation completes, click Finish.

If you are already running the Maxim DL Essentials Edition software, close it 
and restart it. The camera will now be recognized, and the Camera Control 
Window (Figure 6) will appear. Once the driver is installed, the computer and 
software will recognize the SSDSI whenever it is plugged in.

Getting Started During Daylight

We recommend using the SSDSI for the first time during the day. This way, 
you can become familiar with the camera and its functions without having to 
stumble around in the dark. Setup your telescope and mount so the optical 
tube is pointing at an object that is at least a couple of hundred feet away. 
Insert an eyepiece and focus as you normally would.

Since the SSDSI camera is so sensitive to light, you will need to “stop down” 
your telescope aperture to do any imaging in daylight. This can be done by 
creating a simple aperture mask out of a piece of cardboard. The piece of 

cardboard should be larger than the telescope’s aperture. Cut a circular hole in 
the cardboard approximately 1⁄2" in diameter, and place the cardboard over the 
front of the telescope so that it completely covers the aperture except for the 
1⁄2" circle. Affix your aperture mask to your telescope with tape (Figure 7). 

Installing the IR Filter

When using the SSDSI in daylight, the included IR (infrared) filter should always 
be installed. This is because the camera is sensitive to the infrared frequencies 
of light, while the human eye is not. Without the filter installed, the camera will 
pickup infrared light, which will ruin the contrast of the view. For certain types 
of astronomical imaging at night, however, you may want to remove the IR 
filter. This is especially true for imaging red nebulae. 

To install the IR filter on the SSDSI, first unthread and remove the camera’s 
“nosepiece” (Figure 8a). Then, thread the filter into the now-exposed filter 
threads (Figure 8b). Thread the filter so that it is completely seated. Replace 
and rethread the nosepiece, and the IR filter is now installed on the SSDSI. It 
should generally be left on the camera, expect for specific types of astronomi-
cal imaging.

Obtaining First Images
To obtain first images (in daylight) with the SSDSI, follow these step-by-step 
instructions:

Figure 6: The Camera Control Window automatically appears 
when the SSDSI is connected to the computer and the Maxim DL 
Essentials program is opened.

Figure 7: Because the SSDSI is so sensitive to light, an aperture mask is needed on 
the telescope for any imaging during daylight.
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1. Plug the camera into your computer’s USB port.

2. Open Maxim DL Essentials by clicking on the icon now installed on your 
computer’s desktop.

3. Once open, Essentials should connect directly to your camera with the 
Camera Control Window. 

4. To connect the camera to the telescope, simply replace the telescope’s 
eyepiece with the camera. Make sure the securing thumbscrew on the 
focuser drawtube is firmly tightened. 

5. You will now need to refocus the camera for the centered object. Focusing 
will be the hardest thing to do in the initial stages. For daytime imaging, 
open the Screen Stretch Window (in the View menu), and set the stretch 
mode to Moon.

6. In the Camera Control Window, set the mode to Light Color 1x1. Set 
the Seconds (exposure time) to .002 to begin with. In the box underneath 
the Mode box, select Fast Focus. Make sure the Dark Subtract box is 
unchecked.

7. Press the Expose button in the Camera Control Window. The camera 
will now rapidly take short exposures and display them on the computer 
screen. If the image brightness is too bright for the camera, an all (or 
mostly) black screen will result. You will also notice that the Max Pixel (in 
the lower right corner of the Camera Control Window, see Figure 6) will be 
at 65535, which is the maximum pixel brightness value. You can turn down 
the camera’s gain setting by clicking the Setup box in the Camera Control 
Window, then adjusting the Analog Gain slider. Try to get a Max Pixel of 
around 50000 to 60000. If the (daytime) image is still too bright to produce 
an acceptable image on your computer screen, you may need to stop-
down the aperture of your telescope further. Try making another aperture 
mask than has a diameter of only 1⁄4".

8. Now, turn the telescope’s focus knob so the focuser drawtube moves 
slowly inward. The drawtube needs to go approximately 20mm inward from 
where the eyepiece focuses (for most eyepieces). Look at the computer 
screen and adjust the focus knob accordingly to determine best image 
focus.

Note: The camera’s field of view is fairly small. It is approximately equivalent to 
the field of view through the telescope when looking through a typical (i.e. not 
wide-field) 5mm focal length eyepiece. So make sure the object to be imaged 
is well centered in the telescope before connecting the SSDSI, otherwise it 
may not appear in the field of view of the camera.

9. Once focused, image orientation can be changed by rotating the camera 
within the focuser drawtube. Simply loosen the thumbscrew on the draw-
tube and rotate the camera until the desired image orientation is achieved. 
Retighten the thumbscrew on the focuser drawtube when done. You may 
need to slightly refocus (using the telescope’s focus knob) if the focuser 
drawtube has moved a bit inward or outward when the camera was rotat-
ed.

10. When the image is focused and the image looks acceptable, press the 
Stop button in the Camera Control Window.

11. Beneath the Mode box in the Camera Control Window select Single.

12. Click the Expose button in the Camera Control Window. An image will 
appear in a window. 

13. You can now save the image for later processing, if you wish. This is done 
by selecting Save from the File menu.

You have taken your first picture with the SSDSI! This simple method of imag-
ing is exactly how the camera could be used to capture terrestrial subjects 
during daylight hours. Close-up images of birds and other wildlife or faraway 
vistas can all be obtained in this way with the SSDSI. Solar images can also 
be taken during the day with an optional full-aperture solar filter over the front 
of the telescope. 

Take some time to use the camera and Maxim DL Essential software during the 
day to become familiar and comfortable with their basic operation. 

Screen Stretch Window
The function of the Screen Stretch Window (Figure 9) is to properly map the 
image brightness levels captured by the camera into corresponding image 
brightness levels on the computer screen. A typical camera image has each 
pixel (light detecting site, over 437,000 pixels form a single SSDSI image) 
represented as a number (from 1 to 65535) depending on brightness. This has 
to be mapped into the video monitor’s brightness range (from 1 to 255). It is 
important to set the screen stretch appropriately, or a great image may look 
terrible!

Figure 8a-b: (8a.) To install the IR filter, first remove the nosepiece by unthreading 
it from the SSDSI. (8b.) The IR filter then threads directly onto the SSDSI.
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When an image is displayed, you will notice a graph in the Screen Stretch 
Window. This is called the “histogram” of the currently displayed image (Figure 
10). A histogram is a simple bar graph that shows the range of brightness in 
an image. Each bar in the graph represents a level of brightness; the bar to 
the far left in the histogram represents the dimmest pixels, and the bar to the 
far right is for the brightest pixels. The height of the bar is the total number of 
pixels at that brightness level in the image. Every image has a different histo-
gram depending on how much of the image is bright or dark. Directly viewing 
the histogram of your image in the Screen Stretch Window provides an easy 
interface for making decisions on how the screen stretch should be set.

In Maxim DL Essentials, the two parameters entered in the Screen Stretch 
Window are Minimum and Maximum. A pixel that is at the Minimum value 
is set to zero (black), and a pixel at the Maximum value is set to 255 (white). 
An easy way to adjust the Maximum and Minimum values is to move the 
slider arrows located directly under the histogram of the image in the Screen 

Stretch Window. The red slider arrow corresponds to the Minimum value and 
the green arrow corresponds to the Maximum value. Simply left-click and then 
drag each arrow to adjust it to the desired level. The best results are obtained 
by tweaking the arrows (numbers) until the most pleasing display appears. 

There are also seven automatic settings in the Screen Stretch Window. 
Typically, Medium will give good results for deep sky objects, so the default 
screen stretch setting is Medium.

Instead of using the Screen Stretch Window, it is faster to use the Quick 
Stretch facility. This allows you to modify the image appearance instantly with 
small up/down and left/right movements of the mouse. To do this, hold down 
the Shift key, then left-click and drag the mouse on the image. You’ll find this 
feature to be a great convenience when fine adjusting the screen stretch to get 
an image to look its best.

The trick with stretching is determining exactly how to stretch the image for 
best effect. Often there are several different possibilities for the same image. 
Trial-and-error will be the best way to judge what the best screen stretch set-
ting is. Try several different settings until you find one you think looks best. 
When the image is subsequently saved, the screen stretch setting information 
will be kept when the image is next opened.

Use Of The Parfocal Ring
A parfocal ring is included with your camera to help with focusing. The ring is 
intended to be used with a 1.25" eyepiece (not included), preferably one with a 
focal length of at least 10mm to provide high enough magnification for precise 
focusing. The ring goes on the barrel of the eyepiece. When the ring is properly 
positioned on the barrel, you can use the eyepiece to focus, replace the eye-
piece with the camera, and the camera should be close to focused.

To properly position the parfocal ring on the eyepiece barrel, first insert the 
camera into the telescope’s focuser drawtube. Set Maxim DL Essentials so 
the camera displays on the computer’s screen in Fast Focus mode. Focus 
the camera as precisely as possible by visual inspection of the image on your 
computer screen; you do not need to actually capture an image.  If you have 
a focus lock thumbscrew on your telescope’s focuser, tighten it firmly once 
sharp camera focus is achieved (Figure 11a). Place the parfocal ring on the 
eyepiece barrel, and slide it up the barrel as far as it will go and loosely tighten 
the thumbscrew on the ring (Figure 11b). Now, replace the camera with the 
eyepiece, being careful not to change the position of the focuser drawtube. 
Bring the eyepiece into focus by sliding it in and out of the focuser drawtube 
(Figure 11c). Do not use the focus knob of your telescope to focus at this 
time. 

Note: If you cannot obtain a focus with the eyepiece by pulling it out of the 
focuser drawtube, you will need to try another eyepiece. The eyepiece barrel 
should be at least 1" long. Try an Orion 10mm Ultrascopic eyepiece (see the 
catalog or www.OrionTelescopes.com).

Figure 9: The settings in the Screen Stretch Window greatly determine how an 
image will appear on your computer screen.

Figure 10: A histogram is a visual 
representation of the range and levels of 
brightness in an image.
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When the eyepiece is in focus, tighten the securing thumbscrew on the focuser 
drawtube to secure the eyepiece in that position. A signifi cant portion of the 
eyepiece’s barrel should be extending out from the focuser drawtube. Now, 
slide the parfocal ring down the eyepiece barrel, and seat it against the focuser 
drawtube (Figure 11d). Securely tighten the thumbscrew on the ring. The parfo-
cal ring is now properly positioned on the eyepiece’s barrel.

Now that the parfocal ring is properly positioned, focus the camera by fi rst 
focusing with the eyepiece. Simply insert the eyepiece as far as it will go into 
the focuser drawtube, and focus with the telescope’s focusing knob. Then, 
replace the eyepiece with the camera, and the images on the computer screen 
should be very close to focused. Use Fast Focus (or just Focus) to achieve 
a precise focus with the camera. You’ll fi nd that using the parfocal ring on an 
eyepiece will serve to focus the camera much more quickly.  

Astronomical Imaging
Now that you’re familiar with basic camera and software operation, it’s time 
to take the SSDSI out at night under the stars to capture some astronomical 
images. We recommend starting with the Moon, as it is easy to acquire into 
the camera’s fi eld of view, and typically does not require stacking of multiple 
exposures as planetary and deep sky images do.

Imaging the Moon
Imaging the Moon is much like imaging terrestrial objects during the day. Since 
the exposure is very short, it is not critical that the telescope mount be pre-
cisely polar aligned. Best focusing will be achieved by fi rst focusing on a bright 
star near the Moon. Start with short exposures of less than 0.1 seconds.

When the moon is past half full, it is hard to get detail due to the tremendous 
glare off of the lunar surface. Most detail, even on a sliver of a moon, will be at 
the terminator (the tiny thin line between the shadow and light, see Figure 12). 
To get more of the moon in the image, a focal reducer will need to be used. 
For close-ups of craters use a barlow lens (see “Using Focal Reducers and 
Barlow Lenses”). 

Imaging Planets
The best planetary images will be obtained by stacking (combining) many 
individual images in order to improve image contrast, brightness, and detail. 
Because the angular diameter of planets is quite small, you will need to use 
a barlow lens between the SSDSI and telescope to extend the effective focal 
length of the system and increase image scale (see “Using Focal Reducers 
and Barlow Lenses”).

Figure 11a-d: (11a.) To properly set the position of the parfocal ring on an 
eyepiece, fi rst focus the camera in the telescope. If you have a focus lock thumbscrew 
on your telescope’s focuser, tighten it. (11b.) Place the parfocal ring on the eyepiece’s 
barrel and slide it all the way up. Tighten the thumbscrew on the ring. (11c.) Remove 
the camera, and focus the eyepiece by sliding it in-and-out of the focuser drawtube. 
When eyepiece focus is achieved, tighten the thumbscrew on the focuser drawtube 
to secure the eyepiece in that position. (11d.) Now, loosen the thumbscrew on the 
parfocal ring, slide the ring all the way forward, and retighten the thumbscrew on the 
ring.

11a

11c

11b

11d

Focus lock 
thumbscrew

Parfocal ring

Focuser drawtube 
thumbscrew

Parfocal ring 
thumbscrew

Figure 12: The Moon’s surface detail looks the best along the terminator.



Figure 13: The Combine Images window allows “stacking” of 
individual images into one high-quality resultant image.
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Since you will be taking multiple images over a period of time, it is important 
the mount be polar aligned in order to keep the planet within the field of view 
of the camera and to prevent image blurring due to poor tracking during each 
exposure. To this end, you should also have the right ascension (R.A.) motor 
drive engaged. Do not bother trying to obtain a perfect polar alignment, as that 
will only be important for taking longer exposure images of deep sky objects; 
most planetary exposures will be less than a few seconds.

To take multiple images of a planet for stacking:

1. Acquire the planet into the field of view of your telescope (barlow lens 
attached) with the eyepiece that has the parfocal ring attached to the 
planet, and center the planet in the eyepiece’s field of view. Focus the 
eyepiece with the telescope’s focuser. 

2. Now, remove the eyepiece and replace it with the SSDSI. If the parfocal 
ring was set properly on the eyepiece, the camera should be close to 
focused.

3. In the Camera Control Window, set the Mode to Light Color 1x1. Set 
Seconds (exposure time) to 0.5 seconds to begin with. In the box below 
the Mode box, select Fast Focus (Focus can also be used here). Click the 
Expose button.

4. Focus the camera using the telescope’s focus knob. If you are having trou-
ble determining best focus, try focusing on a bright star near the planet. 
You can also use the histogram functions for most accurate focus; this will 
be explained later (see “Focusing”). Click the Stop button in the Camera 
Control Window when camera focus is achieved.

5. Now, in the box beneath the Mode box, choose Autosave. Set the number 
of images you would like the camera to take under Autosave (start with 10 
or so), select the file folder in which you would like to save the images with 
Folder, and enter in a Base filename for the captured images. Typically the 
name of the object being imaged, such as “Mars1”, will be entered here. 
If “Mars1” is the Base filename, and you choose to Autosave five images, 
then the images will appear in the selected file folder as “Mars1_0001.fit”, 
“Mars1_0002.fit”, “Mars1_0003.fit”, “Mars1_0004.fit”, and “Mars1_0005.
fit”. 

6. Click Expose, and the camera will commence capturing and saving the 
images.

Now that we have multiple images of the planet, we will combine the imagesto 
form one high-quality resultant image. To do this:

7. Select Open from the File menu. Find the folder you indicated with Folder, 
open it, and select all images for stacking using the mouse left-click and 
the Shift key. All of the individual images selected will open in Maxim DL 
Essentials.

Note: In order to combine images, the images must first be opened in Maxim 
DL Essentials.

8. Select Combine from the Process menu. In the pop-up window, you will 
see all of the images currently open in Maxim DL Essentials. Choose the 
individual images you want to stack and press the >> button, or simply 
click Add All. Click the OK button when done.

9. The Combine Images window will appear (Figure 13). For Align Mode, 
choose Planetary. In the Output box, select Average. 

10. Now, you can see how each individual image looks by using the Next 
Image and Previous Image buttons. If you see an image that looks poor, 
you can reject it from the stack by clicking the Reject Image button.

Note: At least one image must be used as the reference image for the stacked 
images to be overlaid upon. The default uses the first image for the reference 
image. If you reject the first image or otherwise want to use another image as 
the reference, click the Set As Reference button when the desired reference 
image is actively displayed. If the image currently chosen as the reference is 
rejected from the stack, and another reference image is not selected, you will 
not be able to Overlay All Images.

11. Now, click the Overlay All Images button. All of the selected images will 
stack on top of each other to form one resultant image. Click OK.

You have now composed your first planetary image. Use Save under the File 
menu to save your image at this time. To make it look its best, you will want 
to adjust the Screen Stretch Window to Planet. You may also want to do 
some image processing, see the section entitled “Image Processing” for more 
information.
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Imaging Deep Sky Objects
To capture breathtaking images of deep sky objects, such as galaxies, nebu-
lae, and star clusters, much longer exposures are needed. As with planetary 
imaging, we will take several individual images and stack them together to 
form one high-quality resultant image. But while planetary images are formed 
by stacking many exposures of less than 5 seconds, deep space images will 
generally be comprised of individual images of a minute or longer! 

Because of this, polar alignment and motor drive tracking must be very 
accurate. If not, images will be blurred and stars will not appear round. Also, 
because camera noise increases greatly over exposure time (due to internal 
heat generation), we will need to suppress the inherent camera noise with the 
built-in thermoelectric cooler (TEC). The 12VDC cable should be connected 
to an appropriate power source and plugged into the SSDSI to turn the TEC 
cooling unit on. 

To start:

1. Acquire the deep sky object into the field of view of your eyepiece that has 
the parfocal ring attached to it, and center it in the eyepiece’s field of view. 
Focus the eyepiece with the telescope’s focuser. Make sure your equatorial 
mount is well polar aligned, and the R.A. motor drive is on and engaged.

2. Remove the eyepiece and replace it with the SSDSI. If the parfocal ring was 
set properly on the eyepiece, the camera should be close to focused.

3. Precisely focus the camera by using the telescope’s focus knob and the 
Fast Focus (or Focus) setting in the Camera Control Window. Set the 
Mode to Light Color 1x1, and try an exposure time of a few seconds to 
start. If you are having trouble determining best focus, try focusing on a 
bright star near the deep sky object. If there are no suitably bright stars in 
the camera’s field of view, you may need to slew the telescope away from 
the deep sky object to a bright star, focus on the bright star, and then re-
center the deep sky object in the camera. When you have a good focus, 
press the Stop button in the Camera Control Window

4. Now, in the box under the Mode box in the Camera Control Window, 
select AutoSave. Set the number of images you would like the camera 
to take under Autosave (start with 5 or so), select the file folder in which 
you would like to save the images with Folder, and enter in a Base file-
name for the captured images. Typically the name of the object being 
imaged, such as “OrionNebula1”, will be entered here. If “OrionNebula1” 
is the Base filename, and you choose to Autosave five images, then the 
images will appear in the selected file folder as “OrionNebula1_0001.fit”, 
“OrionNebula1_0002.fit”, “OrionNebula1_0003.fit”, “OrionNebula1_0004.
fit”, and “OrionNebula1_0005.fit”. Try exposures of 30 Seconds to start.

5. Click Expose, and the camera will commence taking the images.

Note: When the camera is taking long exposure images, it is critically important 
not to touch, shake, or otherwise disturb the telescope, or a blurred image will 

result. Also, make sure no surrounding light shines into the telescope during 
the exposure.

Now that you have multiple images of the deep sky object, we will combine the 
images to form one high-quality resultant image. To do this:

6. Select Open from the File menu. Find the folder you indicated with Folder, 
open it, and select all images for stacking using the mouse left-click and 
the Shift key. All of the individual images selected will open in Maxim DL 
Essentials.

Note: In order to combine images, the images must first be opened in Maxim 
DL Essentials

7. From the Process menu, select Combine.

8. In the Select Images window, click Add All. Then click OK.

9. The Combine Images window will appear. For Align Mode, choose Manual 
1 star – shift only. (If you have field rotation due to a poor polar alignment, 
then you can use the Manual 2 stars align mode.) In the Output box, select 
Average. Make sure the Use Centroid and Auto Next boxes are checked.

10. Now, find a well-shaped (circular) star in the first image displayed. Use the 
mouse to center the crosshairs on the selected star and left-click. 

11. The next image will now be displayed; center the crosshairs on the same 
star in this new image, and left-click again. Repeat this for all the open 
images; a chime will sound when you have gone through all the open 
images. (If you use the Manual 2 stars align mode, then select another 
alignment star in the first image displayed after you hear the chime.)

12. If you find an image that looks poor, you can reject it by clicking the Reject 
Image button. Use the Next Image (and/or Previous Image) button to con-
tinue going through the open images after an image is rejected.

Note: At least one image must be used as the reference image for the stacked 
images to be overlaid upon. The default uses the first image for the reference 
image. If you reject the first image or otherwise want to use another image as 
the reference, click the Set As Reference button. If the image currently chosen 
as the reference is rejected from the stack, you will not be able to Overlay All 
Images.

13. Now, click the Overlay All Images button. All of the selected images will 
stack on top of each other to form one resultant image. Click OK.

Adjust the Screen Stretch Window to Medium (or otherwise manually adjust 
for best image appearance), and use Save under the File menu to save your 
image. You can now perform any wanted imaging processing (see “Image 
Processing”). To get the very best images, however, you should subtract “dark 
frames” from images prior to stacking with the Combine function.
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Dark Frames
To completely eliminate any remaining camera noise, you can take several 
“dark frames”, average them, and subtract them from images before stacking. 
A dark frame is an image taken with no external light coming into the camera. 
What results is an image of the camera’s remaining background noise only. 
When a dark frame containing the camera’s noise pattern is subtracted from 
images (prior to combining them), the noise is essentially eliminated. The dark 
frames can be taken before or after the “light” images are acquired, but if they 
are taken beforehand, the dark frame subtraction process can be automated.

Note: To most effectively use dark frames to subtract noise out of resultant 
SSDSI images, it is important to take dark frames close to the actual time of 
taking the “light” images. This is because temperature changes will cause the 
noise pattern in the SSDSI to change over time. So, it is best to take some dark 
frames immediately before or after the “light” images are taken. 

Important Note: Dark frames (Dark Raw 1x1) should only be subtracted from 
Light Raw 1x1 images. If you try to subtract dark frames from images that are 
already color-converted (i.e. Light Color 1x1 images) the resultant image color 
will be incorrect .

To take dark frames for subtraction from “light” images:

1. In the Camera Control Window, set the Mode to Dark Raw 1x1.

2. Set the exposure time to whatever you set it to (or will set it to) for taking 
actual (“light”) images.

Note: When taking dark frames, do not change any of the settings in the Setup 
button from what they were (or will be) when “light” images are taken.

3. In the box beneath the Mode box, choose Autosave. Now set the number of 
dark frames you would like the camera to take under Autosave (3 to 10 will 
generally suffice, as these will be averaged together), select the file folder 
in which you would like to save the dark frames with Folder, and enter in a 
Base filename for the captured dark frames. Typically the name of the object 
being imaged with the word “dark” added, such as “OrionNebula1dark”, 
will be entered here. If “OrionNebula1dark” is the Base filename, and 
you choose to Autosave five images, then the images will appear in the 
selected file folder as “OrionNebula1dark_0001.fit”, “OrionNebula1dark_
0002.fit”, “OrionNebula1dark_0003.fit”, “OrionNebula1dark_0004.fit”, and 
“OrionNebula1dark_0005.fit”. Using the word “dark” in the Base filename 
will help you distinguish between light and dark frames when combining 
later.

4. Click Expose, and Maxim DL Essentials will indicate the camera needs to 
be covered to take a dark frame. Cover the front of the lens you are imaging 
through, and then click OK. The camera will commence taking and saving 
the dark frames.

Now that you have acquired several dark frames, combine them into a single 
averaged dark frame for subtraction from “light” images:

5. In the Process menu, select Setup Dark Subtract. 

6. In the window that pops-up, click Remove All if any filenames appear in 
the window.

7. Click Add, and select the file folder location for the dark frames taken. 
Select the dark frames and click Open.

8. The selected dark frames will now appear in the pop-up window. Click OK.

You are now ready to subtract the averaged dark frame from “light” images. 
This should be done to individual light images BEFORE combining them 
together. There are two ways to do this. If you take dark frames first, before 
taking light images, then you can automatically subtract the averaged dark 
frame from each individual light image as it is captured. If you take dark frames 
after you have already taken the light images (using Light Raw 1x1), then you 
can subtract the averaged dark frame from each individual image before you 
combine them into a single, final resultant image.

To automatically subtract the averaged dark frame from “light” images as they 
are captured: 

1. Setup the averaged dark frame as outlined previously. 

2. Acquire the deep sky object into the field of view of your eyepiece that has 
the parfocal ring attached to it, and center it in the eyepiece’s field of view. 
Focus the eyepiece with the telescope’s focuser. Make sure your equatorial 
mount’s motor drive is on and engaged. Remove the eyepiece and replace 
it with the SSDSI. If the parfocal ring was set properly on the eyepiece, the 
camera should be close to focused. Precisely focus the camera by using 
the telescope’s focus knob and the Fast Focus (or Focus) setting in the 
Camera Control Window. 

3. In the Camera Control Window, click the Dark Subtract square so it is 
checked. Once this box is checked, every subsequent light frame taken 
with the camera will have the averaged dark frame automatically sub-
tracted. 

4. Now, set the Mode to Light Raw 1x1. In the box under the Mode box, select 
AutoSave. Set the number of images you would like the camera to take 
under Autosave (start with 5 or so), select the file folder in which you would 
like to save the images with Folder, and enter in a Base filename for the 
captured images. Set the exposure time equal to that of the dark frames 
taken prior.

5. Click Expose, and the camera will commence taking the images. When it 
saves each image file to its designated Folder location, it will automatically 
subtract the averaged dark frame.
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6. Before these images are ready for stacking, they must be converted from 
raw format to color format. To do this, open all images to be stacked in 
Maxim DL Essentials. Click on one of the images and select Covert Raw 
to Color from the Process menu. For convenience, there is a button on 
the toolbar that you can click instead of using the menu. Click the Reset 
Background Level and the Reset Scaling button (scaling can be used to 
fine-tune the color balance later on). Turn off Anti-Alias Filter. Click OK. 
Repeat this for all the open images.

These images have the averaged dark frame subtracted and have been color 
converted. These are now ready for stacking (using the Combine function). 
You can Save the individual images, or just save the combined image after 
stacking.

If you have already taken your “light” images (remember that these must be 
Light Raw 1x1 NOT Light Color 1x1), then you will need to manually subtract 
the averaged dark frame from each image prior to stacking them into one 
combined image. To do this:

1. Open all “light” images to be stacked in Maxim DL Essentials. Do this with 
the Open command in the File menu. 

2. Click on one of the opened images, and select Dark Subtract from the 
Process menu. The averaged dark frame has now been subtracted from 
the selected “light” image. Repeat this process for all of the “light” images 
opened in Maxim DL Essentials. 

3. Before these images are ready for stacking, they must be converted from 
raw format to color format. To do this, click on one of the opened images 
and select Covert Raw to Color from the Process menu. For convenience, 
there is a button on the toolbar that you can click instead of using the 
menu. Click the Reset Background Level and the Reset Scaling button 
(scaling can be used to fine-tune the color balance later on). Turn off Anti-
Alias Filter. Click OK. Repeat this for all the open images.

You can save each image after dark frame subtraction and color conversion 
(using Save from the File menu), or you can just save the final combined image 
once the individual images have been stacked using the Combine function.

Note that the Light Color 1x1 mode is really just for quick previewing how 
an image might look, and is generally not often used. For most astronomical 
imaging, the Light Raw 1x1 is the mode that should be used; this allows for 
Dark Raw 1x1 frame subtraction, with subsequent color conversion with the 
Convert Raw to Color command.

Light and Dark Mono 2x2 Modes
For added convenience and versatility, the SSDSI’s individual pixels (light-
detecting sites) can be “binned” into units of two-by-two pixels (i.e. four 
individual pixels create one binned 2x2 pixel). This creates larger and more 
sensitive pixels, but with decreased resolution. This can be useful for some 

types of astronomical imaging, such as capturing faint nebulae. It can also be 
useful for quick-checking the aiming of the telescope or framing of objects 
within the field of view of the camera before using the normal Light Raw 1x1 
mode to actually capture images.

To use in “2x2” mode, select Light Mono 2x2 mode for capturing “light” 
images, and Dark Mono 2x2 mode to capture dark frames for averaging and 
subtracting. Images can be combined and processed in the same way as Light 
Raw 1x1 images, except the Convert Raw to Color command does not apply 
(as the 2x2 images are monochrome only). 

Image Processing
After you have captured and combined individual images (with or without dark 
frame subtraction) into a single resultant image, you may want to perform 
some additional image processing to bring out subtle details or to make the 
image appear more pleasing overall. Maxim DL Essentials contains several 
functions which serve to do this.

Make Pixels Square
This command provides a one-step adjustment of the image aspect ratio. 
It uses the pixel aspect ratio determined by the file header and interpolates 
the image to make the aspect ratio 1:1. This generally has a very mild affect 
when applied to images. For best results, this function should be applied to 
individual images before stacking (for best image alignment), but can be used 
after stacking as well.

To use this function, simply select Make Pixels Square from the Process menu 
for any image currently opened in Maxim DL Essentials.

Unsharp Mask
An Unsharp Mask is fairly simple in concept. First, a copy of the original image 
is smoothed (low-pass filtered) to create the mask. This mask is then scaled 
down in intensity by some factor (usually 50-95%), and then subtracted from 
the original image. The result of subtracting a blurred copy of the image from 
itself is to make a sharper image. This works because you are partially remov-
ing parts of the image that are smoother, while leaving untouched the parts 
of the image with fine detail. Usually the math is adjusted so that the average 
pixel values in the final image are the same as the original. 

To apply Unsharp Mask to an image:

1. Select Unsharp Mask from the Process menu.

2. In the pop-up window (Figure 14), the Low-Pass Filter can be set to Mild 
or Strong.

3. The Mask Weight is used to control the strength of the mask. The mask 
weight is in percent; the higher the number, the stronger the mask. 
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4.  Reference the Preview Image (or click on the Auto Full Screen preview 
button), and adjust the settings. This allows you to rapidly adjust the set-
tings until you are satisfied with the results. 

5. Click OK when the image looks its best.

It is best to use a light touch with this command, to avoid over-processing the 
image. Over-processing can create artifacts; i.e. features in the image that are 
not real. It also amplifies the noise in the image.

Color Balance
The sensitivity of most CCD cameras as a function of wavelength (color) is dif-
ferent from the response of the human eye. The filters used for creating color 
composites also have their own characteristics, as do the telescope optics. 
Although “perfect” color rendition is an elusive if not impossible goal (all indi-
viduals see colors slightly differently), it is straightforward to get “good” color 
balance with simple weightings. This is where the Color Balance command (in 
the Process menu, Figure 15) comes in handy to touch up the resultant colors 
in your images. Use the Preview Image to see how altering these parameters 
will affect your image (or click the Full Screen button to see the changes 
applied to your full image).

Color images from CCD cameras typically require a background level adjust-
ment. This is accomplished by bringing the background level (or bias) in each 
color plane down to zero. Each of the Background Level values is subtracted 
from every image pixel in its color plane. Any pixel values that become nega-
tive are forced to zero. The Auto button automatically determines the settings 
necessary to equalize the image background in all three color planes. The 
Reset button resets the background level subtraction to zero on all planes. 

Scaling adjustment (entered as a percentage) allows you to compensate for 
transmittance differences between the filters used to acquire the three color 
planes. Values of 100% result in no change. The scaling percentages can be 
typed in or adjusted using the “spin” controls (small up and down click arrows 
to the right of the scaling numbers). The Preview Image is particularly helpful 
in monitoring the results when using the spin controls. The Reset Scaling but-
ton resets to 100% on all three planes.

The Click On White Area to Set Scaling check box enables the operation of 
the mouse to set the scaling. Set the Background Level first (you can use 
Auto), then click on a white object (e.g. a neutral-colored star) in the image (not 
the Preview Image) with the mouse. The Scaling settings will automatically 
be adjusted to make the selected point appear white. If an area of the image 
is known to be white (or gray), this is an easier way to determine the scaling 
factors, and can be used to instantly color balance the image. 

Stretch
The Stretch command (located in the Process menu, Figure 16) modifies the 
brightness and contrast, and optionally the range (maximum and minimum 
pixel values) of an image. Unlike the screen stretch settings in the Screen 
Stretch Window, which only affects the how an image appears on the com-
puter screen, the Stretch command actually changes the image data pixel 
values in the memory buffer. In reference to the histogram, the Screen Stretch 
Window changes how the histogram is displayed on the computer screen, the 
Stretch command alters the histogram itself.

Figure 14: The Unsharp Mask function can help bring out 
subtle detail in an image.

Figure 15:  The Color Balance command allows weighting of 
each color plane to improve the overall color appearance of an 
image.
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There are three elements which must be set: the Permanent Stretch Type, the 
Input Range, and the Output Range. You can use the Preview Image to see 
how changing these parameters will affect the resultant image (or click the 
Full Screen button to see the changes applied to your actual image). You can 
also open the Screen Stretch Window to see how changing these parameters 
change the histogram.

For the Permanent Stretch Type, the Linear Only mode is useful for adjusting 
the range of pixels to match a particular file format. The Log mode is useful 
for compressing the dynamic range of the image, but can be rather harsh. The 
Gamma mode allows you to selectively emphasize bright or dim parts of the 
image by entering a suitable Gamma Value. A Gamma of 1 has no effect, less 
than 1 will emphasize faint details, while a value greater than 1 will emphasize 
bright details.

The Input Range can be set to Screen Stretch, which in Linear Mode pro-
duces an output matching the current screen appearance. This is useful in 
producing final images for output to 8-bit image formats which have limited 
range.  Note that the minimum and maximum values are always taken from the 
screen stretch settings for the original image. These can be adjusted dynami-
cally using, for example, Quick Stretch. The Max Pixel selection sets the input 
range from 0 to the brightest pixel in the image. This prevents any image pix-
els from being saturated in the final result, but may produce images with low 
contrast. You can also manually set values with Manual Settings in a similar 
fashion to the Screen Stretch Window.

The Output Range is used when preparing a file to be saved in a format that 
has limited range. The Output Range maps minimum input to zero, and maxi-
mum input to 255, 4095, or 65535 depending on the settings. Any values that 

exceed the limits are clipped. The Unlimited setting disables all limiting and is 
recommended when performing Gamma and Log stretches; it is appropriate 
when the image will be saved in floating point format.

Recommended Processing Sequence
What is the best order to apply the processing functions in? Here is a recom-
mended sequence:

1. Dark Subtract

2. Convert Raw to Color

3. Make Pixels Square

4. Combine

5. Unsharp Mask

6. Color Balance

7. Stretch

For convenience, you can Make Pixels Square after the combine, unless align-
ment requires rotating the images (i.e. Manual 2 stars is used as the Align 
Mode in the Combine Images window). If you need to rotate the images by 
more than a small amount, then you should make them square first to avoid 
geometric distortion between the frames. 

Once you have the combined image, there is a lot more room for experimenta-
tion and tinkering. Be sure to Save a copy of the combined image; otherwise 
you might have to go back to the beginning and stack individual images 
again!

Note on File Format

When saving images (using Save or Save As in the File menu), you have a 
choice of file formats. The default produces .fit files, but .tif, .jpg, .png, and 
.bmp file formats can also be selected. Having a choice of output file formats 
is useful, especially if images will be exported to other software programs for 
additional image processing (like Adobe Photoshop, for instance).

If you save to a file format other than .fit, you will need to check the Auto 
Stretch box, or otherwise Stretch the image to change the Output Range (in 
the Stretch command window) to match the Size Format (in the Save As win-
dow). Otherwise, the Output Range will likely exceed the Size Format, and the 
saved image will be ruined (will turn all white). 

For example, say the Output Range is set to create image brightness values in 
16-bit format, while the Size Format of a specific file format (.jpg, for example) 
may only support 8-bits. Since the 16-bit format sees 65535 brightness levels, 
and the 8-bit format can only support 255 levels, all of the levels above 255 
in the 16-bit image (i.e. the vast majority of the 16-bit brightness levels) will 
be saved at the maximum 8-bit value of 255. So the saved .jpg will have very 
little brightness information from levels 1 to 254 and almost all the brightness 
information at level 255. Thus a white image results.

Figure 16: The Stretch command modifies the data contained 
within the image in order to improve contrast and brightness.
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Using The SSDSI As An Autoguider
A great feature of the SSDSI is its ability to be used as an autoguider for tele-
scope mounts. You can use the SSDSI to autoguide a mount while images are 
being taken with another camera, such as a DSLR. 

Tracking errors are usually sufficiently small on short duration images (15 to 
90 seconds depending on the mount) that guiding is not required. Therefore 
a series of short exposure images can be taken and combined together later 
using the Combine command. However, in many cases a single long exposure 
is superior due to the elimination of extra readout noise and the residual blur-
ring caused in realigning the images.

When taking long exposures with astronomical telescopes, motorized tracking 
is required to compensate for the Earth’s rotation. Most telescope mounts do 
not track accurately enough for long-exposure imaging without some form of 
additional “guiding”. Manual guiding can be done by an observer watching a 
star (“guide star”) through a telescope (“guide scope”) mounted next to the 
main imaging telescope (on the same mount). The observer makes manual 
corrections to the motor drives via a pushbutton hand controller to keep the 
star centered in the guide scope’s eyepiece over time. In this way the track-
ing accuracy of the main telescope (with imaging camera attached) can be 
assured. Stars in the resultant images will be crisp and round. Manual guiding 
can be very tiresome and tedious, however, especially if taking many long 
exposures throughout the night.

The SSDSI can be used as an “autoguider” to take the place of the observer so 
that no manual guiding corrections are needed during long exposure imaging. 
Keep in mind, however, that when the SSDSI is used in this way, you will need 
another telescope and camera (such as a DSLR) on the mount to actually take 
images with; the SSDSI takes the place of the observer viewing through the 
guide scope, but cannot autoguide and image at the same time.

So, in order to use the SSDSI as an autoguider, the following equipment will 
be required:

• Astronomical telescope mount capable of accepting autoguider drive com- 
   mands. 

• Cable to connect computer (serial port) to mount’s autoguider jack (mount  
   specific).

• Main telescope for imaging.

• Camera for imaging (which may require its own computer).

• Guide scope for guiding.

• Any required rings or brackets for guide scope attachment to the mount  
   along with the main telescope.

Computer to Mount Connection
In order for autoguiding with the SSDSI to work, you need a way to send com-
mands from the computer to the telescope mount. This is generally done with 
a cable connecting the computer’s serial (COM) port to the mount’s autoguider 
jack; this cable is generally mount specific, so contact the dealer you pur-
chased your mount from for the proper cable for your mount.

If your telescope mount is supported by the ASCOM platform, it is a simple 
task to setup the autoguider to send commands (through the computer) to the 
telescope mount. To do this:

1. Insert the included CD-ROM into your computer.

2. When the Launcher appears (Figure 4), click on the Install ASCOM button 
and follow the automatic ASCOM platform installer instructions. Restart 
your computer as indicated when done.

3. Connect the SSDSI to your computer and open the Maxim DL Essentials 
software.

4. In the Camera Control Window, click on the Guide tab (Figure 17).

5. Click on the Settings button. 

6. In the window that pops-up (Figure 18), select ASCOM for the Autoguider 
Output Control Via. Click the Setup button under the Autoguider Output 
heading.

7. The ASCOM Telescope Chooser (Figure 19) will appear. Select your tele-
scope model from the provided choices. If your model does not appear, it 
is not supported by the ASCOM platform.

Figure 17: The Guide tab in the Camera Control Window is where the SSDSI’s 
autoguider functions can be accessed.
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8. After you have selected your telescope model, click the Properties but-
ton.

9. In the window that pops-up, choose your specific Scope Type and desired 
Serial Port where the computer will send commands to the mount. Click 
OK when done.

10. Click OK in the ASCOM Telescope Chooser window.

11. In the Settings window, click the Close button.

Some telescope mounts accept commands in the “LX200 Protocol”. For 
these mounts, it is not necessary to install the ASCOM platform to have the 
computer “talk” to the mount. To setup the autoguider for mounts that use the 
LX200 Protocol:

1. Connect the SSDSI to your computer and open the Maxim DL Essentials 
software.

2. In the Camera Control Window, click on the Guide tab.

3. Click on the Settings button. 

4. In the window that pops-up, select LX200 Protocol for the Autoguider 
Output Control Via. Select the COM Port of the computer you would like 
to use to send commands to the telescope 

5. Click the Apply button, then click the Close button.

Autoguider Calibration
In order to properly control the mount, you must calibrate the system. The 
exact orientation of the SSDSI, the focal length of the guide telescope optics, 
and the speed of the motor drive all affect the calibration. To perform autogu-
ider calibration:

1. Switch to the Guide tab.

2. Set the X and Y Aggr (aggressiveness) to 8 to start with. Set the Exposure 
to 1.0 second. Under Guide Star, make sure the Watch box is checked.

Note: The X and Y Aggr (aggressiveness) controls on the Guide tab allows you 
to adjust how vigorously star motions are tracked out in each axis. An aggres-
siveness setting of 10 means that the SSDSI attempts to track out 100% of the 
motion, whereas a setting of 1 means that the SSDSI only tracks out 10% of 
the motion. Usually a setting of around 8 or 9 provides the best tracking, since 
it reduces overshoot and helps ignore random motions due to atmospheric 
seeing and wind loads. You should experiment to determine the best setting 
for your particular telescope. 

3. Click the Settings button.

4. Maxim DL Essentials needs to know how fast the telescope moves in right 
ascension (R.A.) and declination (Dec.) when the autoguider commands 
are issued. To do this, the software will Calibrate the mount by moving it 
back and forth on each axis. The Calibration Time determines how long it 
activates the motors each time. The usual value is 5-10 seconds; start out 
with a value of 5. 

5. Make sure all of the Guider Enables boxes are checked. 

6. For Autoguider Output, set Control Via and COM Port as required for your 
telescope equipment. See “Computer to Mount Connection” if you have 
not already done this.

7. Click Apply. You can leave this dialog box open, or Close it if you wish. 

Figure 18: The autoguider Settings window is where the Autoguider Output is 
defined.

Figure 19: The ASCOM Telescope Chooser provides an easy way to establish a 
computer-to-mount communications link if the mount is supported by the ASCOM 
platform.
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8. Make sure that the telescope mount is set to move at 1X sidereal or slower. 
For some mounts, you must set the guide rate manually. The maximum 
usable rate is 1X sidereal. If your mount does not drift quickly, then 0.1X is 
recommended; otherwise use a value between 1X and 0.1X. 

9. On the Guide tab, set to Expose, and click the Start button. A single image 
will be taken. Ensure that a well-focused bright star (near the actual object 
to be imaged) appears in the image. If not, adjust the guide scope and try 
again. Make sure the star is roughly centered.

Note: The algorithm can be confused if another star appears in the frame; to 
minimize this risk, calibrate on an isolated bright star. 

10. Now, set to Calibrate, and click the Start button. A series of five exposures 
will be taken; each time the telescope will be moved slightly. If the tele-
scope does not move, check the Settings. Remember, you have to set up 
a method for sending the autoguider commands to the telescope! 

11. The star should move in an L shape. If it does not move enough, a warning 
message will appear. The recorded positions will be displayed in the scroll-
ing log, along with any error messages. 

Note: If the star does not move far enough, or moves too far (i.e. the star leaves 
the field), the duration of the calibration move commands can be adjusted 
by clicking the Settings command and changing the Calibration Time fields 
(measured in seconds). A longer calibration time will increase the motion of the 
star; a shorter time will decrease the motion. Typical values range from five to 
ten seconds, depending on the correction speed, focal length, and pixel size. 

12. Once you have successfully calibrated, switch to the Track mode. Click 
Start, and watch the star. It should move to the center of the small track 
box, and whenever it drifts off it should be pulled back again. You can 
zoom in the window for a better look. Also the tracking errors will be dis-
played in the scrolling log.

13. If the star bounces back and forth, reduce the aggressiveness for that 
axis. If it corrects too slowly, increase the aggressiveness. Changes to the 
aggressiveness settings take effect immediately. 

You are now ready to take a long-exposure image through the main telescope 
and imaging camera. The SSDSI will continuously send small correction factors 
to the mount’s motor drive to insure steady and accurate tracking throughout 
the duration of the exposure, however long that may be.

Other Autoguiding Notes: 

• If you are using a German equatorial mount you must calibrate with the tube 
on the same side of the mount as it will be when actually imaging.

• The calibration settings need changing if you move the telescope in declina-
tion by more than about five degrees. Select another bright star, and Calibrate 
again.

• If you experience bad guiding in declination and cannot resolve it through 
adjusting the calibration or aggressiveness, you may have a stiction problem 
with your declination drive. Watch which way the star drifts, and turn off the 
Guider Enable checkbox (in the Settings window) that pushes the star in that 
direction. That will prevent the stiction cycle from happening. 

• Make sure that any backlash compensation in the mount is turned off. 

• On most telescopes, the Right Ascension drive likes to have some load push-
ing against sidereal tracking. If the mount is balanced such that it is pulling the 
mount forwards slightly, the gear teeth may bounce back and forth resulting in 
terrible guiding that cannot be corrected by an autoguider. Be sure to always 
balance the telescope such that it “lifting the weight” rather than “allowing it 
to fall”; i.e. heavier on the East side. Note that this may require balancing the 
telescope differently when it is pointed East versus West.

Other Features Of Maxim DL 
Essentials

Edit Menu
Flip - Flips image orientation. “Folds” image about vertical center.

Mirror – Creates mirror image of current image orientation.

View Menu
Zoom – Increases or decreases level of image magnification on computer 
screen. When you zoom in too much, you will start to see the squares of indi-
vidual pixels. When zoomed in, you can use Quick Pan; simply hold down the 
Ctrl key, then left-click and drag the mouse on the image.

Night Vision – Toggles Night Vision mode. The red background helps preserve 
your night vision.

Window menu
These functions alter the way multiple open image frames are arranged and 
displayed within Maxim DL Essential. These functions are very useful for 
organizing the visual display when processing large numbers of raw images 
for stacking.

Note: The Open or Convert AVI File command in the File menu is for the 
StarShoot Solar System Imager, not the SSDSI.
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Tips

Polar Alignment 
Good telescope mount polar alignment is of critical importance for long-expo-
sure CCD imaging. Inaccurate polar alignment leads to image movement over 
time (even with motor drives running and engaged), which limits the amount of 
time an exposure can be taken before the stars begin to streak and blur. 

If your equatorial mount uses a polar axis finder scope, we highly recom-
mend utilizing it for polar alignment. If not, a technique known as the “drift 
method” of polar alignment has been used for many years, and can achieve 
an extremely accurate polar alignment. Unfortunately it is very time consum-
ing, since the drift of a star over time must be observed. The basic idea is to 
let the telescope mount track while watching a star to see which way the star 
drifts. Note the direction of the drift, and correct by moving the mount in the 
appropriate direction.

To perform the drift method of polar alignment: 

1. Do a rough polar alignment by pointing the R.A. axis of the mount at Polaris 
(the North Star).

2. Find a bright star near the meridian (the imaginary line running north-to-
south through zenith) and near the celestial equator (zero degrees declina-
tion). Point the telescope at this star, and center it in an illuminated reticle 
eyepiece (available from Orion). If you don’t have an illuminated reticle 
eyepiece, use your highest- magnification eyepiece.

3. Determine which way is north and south in the eyepiece by moving the 
telescope tube slightly north and south.

4. Now, let the mount’s motor drive run for about five minutes. The star will 
begin to drift north or south. Ignore any east-to-west movement.

5. If the star drifts north, the telescope mount is pointing too far west.  If the 
star drifts south, the telescope mount is pointing too far east. Determine 
which way the star drifted and make the appropriate correction to the azi-
muth position of the mount. Rotate the entire mount (and tripod) slightly 
east or west as needed or use the azimuth adjustment knobs (if your mount 
has them) to make fine adjustments to the mount’s position.

6. Next, point the telescope at a bright star near the eastern horizon and near 
the celestial equator (Dec. = 0).

7. Let the telescope track for at least five minutes, and the star should begin 
to drift north or south.

8. If the star drifts south, the telescope mount is pointed too low. If the star 
drifts north the telescope mount is pointed too high. Observe the drift and 
make the appropriate correction to the mount’s altitude (or latitude); most 
mounts have some sort of fine adjustment for this.

Repeat the entire procedure until the star does not drift significantly north or 
south in the eyepiece. When this is accomplished, you are very accurately 
polar aligned, and should be able to produce good (unguided) images of up 
to several minutes long, assuming the mount’s drives track well with little 
periodic error.

Focusing
One of the hardest things to do in imaging is achieving good focus. You can 
simply watch the computer screen to focus (using Fast Focus or Focus in the 
Camera Control Window), but you can focus “by the numbers” on a bright star 
to get the best focus possible. To do this:

1. In the Camera Control Window, select Light Raw 1x1 mode. 

2. Set the exposure time to 1 to 5 Seconds, depending on how bright the star 
is. 

3. Turn off Dark Subtract. 

4. Now beneath the Mode selector, pick Focus, and then click Expose. The 
camera will take repeated exposures, until you click Stop.

5. Point the telescope at a bright star, and you can focus “by the numbers”:

 • MaxPixel is the value of the brightest pixel in the image. When you are 
in focus, it will be at its highest value. You will need to look at the value 
for several images in succession, because the number will bounce around 
with the seeing. 

Note: If the MaxPixel reaches 65535, the image is saturated and all three focus 
numbers will be inaccurate. Either pick a fainter star, adjust the camera’s 
Analog Gain settings using the Setup button, or use a shorter exposure time. 

 • FWHM, or Full-Width Half Maximum, is the width of the star half-way 
down the sides. This provides a highly accurate measurement when you 
are close to focus. When you are at focus, it will be at its lowest value. 
This number will vary due to seeing, so it is best to look at several images 
before decided.

 • HFD, or Half Flux Diameter, is similar to FWHM, but works much better 
than FWHM when the star is badly out of focus. It can produce a usable 
number even when the star looks like a donut. 

Refocus often throughout your imaging session. This ensures at least some 
of your images will have an excellent focus. It is also not uncommon for tele-
scope motions or movements to alter the focus slightly, so be sure to refocus 
after slewing to any new astro-imaging targets.

Choosing a Site for Astro-imaging
Once you have a focused image, you may find your image shifting and washed 
out. This can be caused by many environmental factors. Poor seeing (move-
ment of molecules in the air, such as heat rising) and poor transparency (mois-
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ture, smoke, or other sky contaminants) will all serve to reduce image quality. 
That is why most major astronomical telescopes are on high mountains in thin 
air, to get above much of the transparency and seeing problems. Also, wind 
will move your telescope and affect images. Your eyes viewing through an 
eyepiece can change slightly to compensate for disturbances like these, but 
the camera can not. Keep these factors in mind when choosing an observing 
site for astronomical imaging.

For the best astro-images, we recommend finding a location with dry air, some 
altitude, and away from city or streetlights. Even a nearby hilltop in the coun-
tryside can provide better viewing conditions than many convenient backyard 
locations.

Loss of Camera Connection
If the computer connection to the camera is interrupted, you will need to 
re-establish connection. This can happen due to several reasons; if a cable 
becomes unplugged, the computer “freezes”, or the software/hardware other-
wise temporarily loses the data coming from the camera. 

To re-establish camera connection, first close the Maxim DL Essentials pro-
gram on your computer. Then, unplug and re-plug the camera into the com-
puter’s USB port. Now, open Maxim DL Essentials, and the Camera Control 
Window should appear indicating re-established connection between camera 
and computer.

Using Focal Reducers and Barlow Lenses
Focal reducers and barlow lenses change the effective focal length of a tele-
scope. These lenses are inserted between the camera and telescope when 
imaging to change image scale.

Focal reducers serve to decrease the focal length of your telescope. This 
increases the field of view seen by the camera (decreases camera magnifi-
cation). This can be very useful for obtaining images of wide-field deep sky 
objects, such as the Andromeda Galaxy or the Pleadies star cluster. Focal 
reducers will usually thread onto the nosepiece of the SSDSI.

Barlow lenses increase the focal length of your telescope, which makes the 
camera’s field of view narrower (increases camera magnification). This is useful 
for planetary imaging. Keep in mind that when the focal length is doubled, the 
image will become four times dimmer, so a longer exposure may be necessary. 
Barlow lenses are generally inserted in the focuser’s drawtube and secured 
with the thumbscrew on the focuser’s drawtube, and the SSDSI’s nosepiece 
is inserted into the barlow and secured with the thumbscrew on the barlow 
lens.

Filters
Any standard Orion 1.25" filter will thread into the front of the SSDSI’s barrel. 

For some types of planetary imaging, you may want to use color filters to bring 
out subtle details. Try using several different color filters on a planet to see 
which filters help best show planetary details.

For imaging deep sky objects under light-polluted skies, you can try a SkyGlow 
Broadband light pollution filer. This helps suppress the light emitted by street-
lights, but still lets most of the light from deep sky objects through. An increase 
in overall image contrast results.

USB Extension Cable
In many instances, it is likely a longer cable for the SSDSI will be needed in 
order to comfortably setup telescope, camera, and computer. We recommend 
purchasing a 10' USB extension cable if you need more cord length (available 
through Orion, check the catalog and/or www.OrionTelescopes.com). 

Care and Maintenance
When the SSDSI is not in use, the cover cap should be replaced on the end 
of the nosepiece. This prevents dust from accumulating on the IR filter or the 
SSDSI’s optical window. If significant dust does accumulate on the filter or 
optical window, or any of the optical surfaces are touched, then they should 
be cleaned.

Any quality optical lens cleaning tissue and optical lens cleaning fluid specifi-
cally designed for multi-coated optics can be used to clean the glass surfaces 
of the IR filter and the SSDSI’s optical window. Never use regular glass cleaner 
or cleaning fluid designed for eyeglasses.

Before cleaning with fluid and tissue, blow any loose particles off the surfaces 
with a blower bulb or compressed air. Then apply some cleaning fluid to a tis-
sue, never directly on the optics. Wipe the optical surfaces gently in a circular 
motion, then remove any excess fluid with a fresh lens tissue. Oily fingerprints 
and smudges may be removed using this method. Use caution; rubbing too 
hard may cause scratches.
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Specifications
CCD Sensor    Sony® ExView HADTM ICX259AK Color

Sensor size   1/3" 

Pixels    752x582 (437,664 total)

Exposure range   0.002 seconds to 9.3 hours

A/D conversion   16 bit

Thermoelectric cooling  Yes, via onboard TEC

TEC current draw  Approximately 0.5A (12VDC), requires  
     optional external power supply

Analog gain control  +10 dB

Oversampling   2x (increases signal-to-noise ratio)

Autoguider capability  Yes

USB connection   2.0 or 1.1

Camera current draw  Aproximately 0.3A (12VDC), powered by  
     USB computer connection

IR filter    Yes, removable

Optical window   Fully coated with anti-reflection coatings

Weight    14 oz.

This device complies with Part 15 of the FCC Rules. Operation is subject to the 
following two conditions: (1) this device nay not cause harmful interference, 
and (2) this device must accept any interference received, including interfer-
ence that may cause undesired operation.

Changes of modifications not expressly approved by the party responsible for 
compliance could void the user’s authority to operate the equipment.

Note: This equipment has been tested and found to comply with the limits for 
a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses and can radiate radio 
frequency energy and, if not installed and used in accordance with the instruc-
tions, may cause harmful interference to radio communications. However, 
there is no guarantee that interference will no occur in a particular installation. 
If this equipment does cause harmful interference to radio or television recep-
tion, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following 
measures:

Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment into an output on a circuit different from that to which 
the receiver in connected.

Consult the dealer or an experienced radio/TV technician for help.

A shielded cable must be used when connecting a peripheral to the serial 
ports.
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One-Year Limited 
Warranty

This Orion StarShoot Deep Space Color Imaging Camera is 
warranted against defects in materials or workmanship for a 
period of one year from the date of purchase. This warranty 
is for the benefit of the original retail purchaser only. During 
this warranty period Orion Telescopes & Binoculars will 
repair or replace, at Orion’s option, any warranted instru-
ment that proves to be defective, provided it is returned 
postage paid to: Orion Warranty Repair, 89 Hangar Way, 
Watsonville, CA 95076. If the product is not registered, 
proof of purchase (such as a copy of the original invoice) 
is required.

This warranty does not apply if, in Orion’s judgment, the 
instrument has been abused, mishandled, or modified, nor 
does it apply to normal wear and tear. This warranty gives 
you specific legal rights, and you may also have other rights, 
which vary from state to state. For further warranty service 
information, contact: Customer Service Department, Orion 
Telescopes & Binoculars, P. O. Box 1815, Santa Cruz, CA 
95061; (800) 676-1343.

Orion Telescopes & Binoculars
Post Office Box 1815, Santa Cruz, CA 95061 

Customer Support Help Line (800) 676-1343 • Day or Evening


